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1. About Layer X Slider
Build Modern & Mobile-Friendly Presentations for your Website in no time!
Layer X Slider WordPress is a high quality image and content slider for WordPress, with
super smooth hardware accelerated transitions. It supports touch navigation with pure
swipe gesture that you have never experienced before. It’s a truly responsive and device
friendly slider which works perfect on all major devices.
Layer X Slider is an awesome layer slider, with the ability of adding any HTML content
(texts, images, …) in layers. You almost have everything in Layer X which is the most
complete among the best products, featuring hotspots, thumbnails, variety of effects, video
support and much more.

2. Main Features
We want Layerx X to integrate into your website as seamlessly as possible. You can upload
a regular image as background, Videos as HTML5 or Youtube, create a social media content
stream or WP posts.

Building sliders has never been easier with our Drag & Drop Visual Editor. Even beginners can manage to
create beautiful presentations with our intuitive workflow.

3. Installation & Setup
Requirements: 2.0.2 or higher WordPress installation
Compatible up to 4.1 – tested and approved
Setting up Layer X Slider is easy, just follow these instructions:
1. Download Layer X Slider .zip file
2. In the WordPress back-end go in Plugins > Add New (http://site.com/wpadmin/plugin-install.php) and Select Upload
3. Upload and activate the plugin
4. Go in Layer X Slider menu item
5. Select a slider or create a new one
6. Copy the shortcode from the bottom of the page, it should look something like
[layer_x alias="slider1"]

4. Updating Layer X Slider
An email is sent to notify buyers of new versions or important bug. Note that you can check
the Change log on our web page to see the current version or important fixes of bugs.

5. Create a Slider
From the plugin’s main page select Create a new slider. Then enter the title and alias of the
slider, something like Slider name and slider-alias.

5.1. Select Slider Content
You can select out of 10 different types of slider content organized in 3 categories: the Default Layer X
Slider, WordPress-based Content and Social Media Content.

5.1.1. Default Slider
A slider that usually contains images from your WP Media library, where slides are created and managed
individually.

5.1.2. All Posts
This is a slider based on a specific category/tag (or multiple categories/tags) of your choice. You can
fetch posts by Categories & Tags, Related, Popular, Recent, Next/Previous. In Post Types - Choose
regular Posts or one of your Custom Post Types and in Post Categories - Use Ctrl-Select to choose
multiple tags/categories.
Slides for Post-based Sliders
A “slide” for a Post-Based slider is a template that will be used for how your post’s
content will be displayed. Only one template is required, meaning only one “slide”
needs to be setup. For more see 5.2. Post-based content.

5.1.3. Specific Posts
In the following
examples, posts with
the ID “23”, “24” and
“25” will be pulled into
the slider. When
including multiple
posts like this,
separate them with a
comma.
Select “Add Popular
Posts” or “Add Recent
Posts” to

automatically grab a list of ID’s for each.

5.1.4. Woocommerce Slider
You can get the
products from
Woocommerce via
this slider. You can
Sort products by
highest to lowest
or vice versa and
enter maximum
number of
products to be
pulled into the
slider in the fields
bellow.
In Regular Price
enter a range of
prices to display. In
Sale Price enter a
range of sale prices
to display.

5.1.5. Flirckr Stream
Fill in all fields in the Flicker content type box. In Slides (max 500) choose the number of items to pull in
from your content source. In Source, select the correct source you want to use like:





User Public Photos - Requires Flickr User URL
User Photoset - Requires Flickr User URL + Photoset Selection
Gallery - Requires Flickr Gallery URL
Group Photos - Requires Flickr Group URL

5.1.6. Instagram Stream
You can get your Instagram Token here - http://www.pinceladasdaweb.com.br/instagram/access-token/
and enter the token inside the field. You also need the user id or hashtag you want to use. To get the
user id follow these instructions http://www.otzberg.net/iguserid/ .

5.1.7. YouTube Playlist/Channel
The “YouTube Stream” content source is used to display a full stream of videos from a channel/playlist.
If you want to display a single youtube video, please select the content source “Default Slider” and add a
video layer in the slide editor.
Enter the channel id or select the appropriate playlist if you want include a playlist in your slider.

5.1.8. Vimeo Stream
The “Vimeo Stream” content source is used to display a full stream of videos from a
user/album/group/channel. If you want to display a single vimeo video, please select the content source
“Default Slider” and add a video layer in the slide editor. You can enter the User, Group, Album or
Channel.

5.1.9. Facebook
You can register your own app by following these instructions https://developers.facebook.com/docs/apps/register .
Facebook auto-generates an app secret associated with your application. Copy the App id and secret,
enter the page name (slug) and select what to display in Source.

5.2. Post-based Content
A "Post-Based Slider" is a slider based on a specific category/tag (or multiple categories/tags) of your
choice. In Post Types select regular Posts or one of your Custom Post Types. In Post Categories you can
use Ctrl-Select to choose multiple tags/categories.
When choosing "Specific Posts" you can enter specific Post ID's to be used as the slider's source.
As an example posts with the ID “23”, “24” and “25” will be pulled into the slider. When including
multiple posts like this, separate them with a comma. Select “Add Popular Posts” or “Add Recent Posts”
to automatically grab a list of ID’s for each.

5.2.1. Add some post-based content to the slide
Follow this guide to setup the content:

-

-

Save your settings and then click "Edit Slides". A “slide” for a Post-Based slider is a template that
will be used for how your post’s content will be displayed. Only one template is required,
meaning only one “slide” needs to be setup.
Set "Featured Image" as the "Main Background" source.
Add some Text/HTML Layers to pull in your post content.
Then click the "Edit Meta" icon for the layer, and choose one of the listed post content options.
Next style the layer as you would a regular text field, and then save the current slide.

5.3. Select Slider Type
There are three types: Default, Hero Scene, Carousel Slider. Hero is essentially a “one slide”
Slider. When it is selected, multi-slide options such as navigation, autoplay, will be hidden from the
slider’s main settings automatically.
When Carousel is selected a new 3 sections will become visible in Advanced Settings where you can
setup a wide variety of carousel views. Those are the Carousel, Transformations and the Aligns
sections.
You can load settings preset template for your current slider, or save the slider’s currently selected
settings as a preset template to be used for future sliders.

5.4. Slide Layout
Auto
The default “responsive” layout. The slider will always inherit the width of its immediate HTML
container, allowing it to fit seamlessly inside your theme’s page layout.
Full-Width
Slider will always stretch across the entire width of the screen.
Full-Screen
Slider will always become the same size as the entire screen size.
Layers Grid Size
In order to properly resize content in the slider, the slider needs starting point size values in order to
make the responsive calculations.
For example, let’s say you have an “Auto” layout, with a “Layers Grid Width” of “1000px”. But then let’s
say the slider is placed inside your web page, which has a content container width of 2000px. In this
example, because the theme’s content container width (2000px) is literally 2x the slider’s “Grid Width”
(1000px), all of the slider’s content will scale up to 200% its original size.
So let’s say you have a text layer with a 24px font-size. In the above scenario, the text size would scale
up to 48px.
But now let’s say the slider is viewed on a mobile device with a screen width of 250px wide. Because
250px is 1/4 the size of the slider’s “Grid Width”, the content would be scaled down to 1/4 its original
size, which means a text layer with a 24px font-size would then become 6px.

Now in the above scenario, text with a 6px font size is often too small to visibly read, which is why we
decided to create “Dynamic Grid Sizes”. Essentially what this does is allow you to style your content for
4 different screen sizes. For example, instead of the default resizing behavior described in the scenario
above, you could specifically set the font size for “Tablet” to be 16px, allowing for a much better textreadability experience.
An easy way to think about this is to compare it to CSS Media Queries, where the “max-width” in a
media query would be the “Grid Width” in the screen options below.
In order to enable the ability to design content for multiple screen sizes, you first need to set the
“Custom Grid Size” to “On”.
Then once you’ve activated at least one “Custom Grid Size”, when you edit a slide, you can set different
styles (such as varying font-sizes) for each enabled “Custom Grid Size”.
Advanced Options for "Auto" and "Full Width"
1. Overflow Hidden - Useful for Carousel sliders. Otherwise, if you have any content that's placed
outside the main slider, leave this "Off".
2. Respect Aspect Ratio - The "Layers Grid" height essentially acts as the "max-height" for the slider.
But setting the "Respect Aspect Ratio" option to "On" will allow the slider's height to expand beyond this
value (effectively disabling a "max-height" for the slider).
3. Min. Height - Sometimes a slider can be quite wide with a short height. But then when the slider is
resized down, the short height may become too short. In these cases, applying a "min-height" value will
ensure that the slider never becomes too short when its resized down.
4. Max. Width - Useful for restricting the slider's width. For example, if the slider's width is covering
the entire width of the screen, but you want the slider's width to match your theme's boxed container
instead, you could enter a number such as "960" here, and then then slider's width would never
advance past 960px wide.
Advanced Options for Full-screen
1. Min. Height - Apply a minimum height in pixels to your FullScreen slider, ensuring that the slider's
height is never smaller than this number.
2. Disable Force Full Width - Useful for sites with a main menu placed at the left or right side of the
page.
3. Containers - Useful for placing a "FullScreen" slider in between your page's header menu and
footer.
4. PX or % - Reduce the slider's height by a specific amount of pixels or percentage.

5.4. Advanced Settings
In Advanced Settings you can change more details about your slider.

5.4.1. Defaults
Set the default individual slide settings
For example, let’s say you always want your individual slides to start off with a “Slide to Top” transition.
Adjusting the “Transitions” value will set it up so all new slides have a “Slide to Top” transition by
default.
Or if you already have individual slides created, you can change the value of “Transitions” and then
select its checkbox, and then click the “Overwrite Selected Settings on all Slides” button, and the main
transition for all existing slides will be changed to the new default value.
Progress Bar
The timer line that illustrates the amount of time before the next slide is shown.
If active, choose the progress bar’s position (top or bottom of slider), its height in pixels, and also its
color and transparency level.

5.4.2. Slideshow
Stop Slide on Hover
Stop slider progress when the user hover their mouse over the slider.
Stop Slider After..
Amount of Loops:
Stop the slider after all slides have looped a set amount of times.
At Slide:
Stop the slider at a specific slide.
Shuffle / Random Mode
Stop slider progress when a user hovers over the slider.
Loop Single Slide
Stop slider progress when a user hovers over the slider.

Stop Slider out of Viewport
Stop slider when the page is scrolled and the slider is no longer visible.
Out of Viewport:
Wait:
Only start the slider when it’s scrolled into view (useful for sliders further down the page).
Pause:
Pause the slider when it’s scrolled out of view.
Area out of Viewport:
This is a percentage of the slider that needs to be inside/outside the viewport before slider starts or
pauses.
Next Slide on Focus & Disable Blur/Focus Behavior
Browser behavior varies when switching between windows/tabs (JavaScript stops executing, etc.). But
these options will often correct slider issues related to switching between tabs and windows.

5.4.3. First Slide
Alternative 1st Slide
Normally the slider will always start with slide #1. But if you’d like your slider to start with a different
slide, enter the slide’s number here.
First Transition Active
Sometimes when your slider first starts, it’s more elegant to have a different transition such as a simple
fade at the very beginning. Use this option if you’d like to specify a special, initial transition for the very
first slide.
When set, the special transition will only be executed on the very first slide once. Then once the slider
loops, the original slide will default back to its individual slide transition settings.

5.4.4. Appearance
Shadow Type
Shadows will be shown beneath the slider. Choose between 6 different styles, or choose “No Shadow”
(the default option). And preview the Shadow Type as shown in the Primer section above.

Dotted Overlay Size
Dotted overlays are transparent grid-like graphics that will be placed above the slides, giving the slider a
“mesh” type look (4 styles available). Preview the options as shown in the Primer section above.

Slider Background
This is the main background. Normally if your individual slides have their own background images, the
main background would only be visible when the slider first loads, and before the first slide displays.
But setting a background here for the slider itself is particularly useful for when you’re using
“Transparent” slides (slides with no background image).
Choose a solid color or set an image as the background. Apply some padding to give your slider a
border. And set specific background image options such as Background Fit, Background Repeat, and
Background Position.

5.4.5. Spinner
This is the animated preloader graphic. The spinner will be shown when the slider first loads, and also
for additional slides if LazyLoad is being used. Choose between 6 different spinner styles, or choose
“Off” for no spinner.

5.4.6. Mobile
Disable Slider on Mobile
Choose to disable the entire slider on mobile devices. If disabled, you can replace the slider with a
simple fallback image.
Disable Ken Burn on Mobile

The Ken Burns effect is an advanced animation that looks great on desktop computers, but for mobile
devices, providing a more simple slider can sometimes be a better user-experience. Depending on your
preference, toggle the KenBurns effect on and off for mobile with this setting.
Hide Element Under Width
Choose to hide the entire slider, individual layers, or all layers when the screen size is below a specific
pixel width (i.e. 640px, etc.).
Hiding layers is useful for when lots of content displays nicely on desktop, but there isn’t really enough
real estate (screen space) to fit everything on mobile.
“Predefined Layers” are specific layers you’ve designed to “hide” under the pixel width set here for this
setting.

5.4.7. Position
Position on the page
This is the default alignment for the slider. Options are “left”, “center” or “right”.
Margin Top, Margin Bottom
Add some space above or below the slider in relation to other content on the page. Both positive and
negative numbers supported.

5.4.8. Arrows
Enable Arrows / Arrow Style
Choose to enable/disable navigation arrows, and if enabled, choose between 15 different pre-built
styles.
Visibility
Always Show
Yes = Show navigation element at all times
No = Only show navigation element on mouse hover
Hide Under Width
Disable navigation element below a certain screen width. For example, thumbnails look great on
desktop, but are often better hidden on smaller screens.
Hide Over Width

Disable navigation element above a certain screen width.
Practical application of "Hide Under Width" and "Hide Over Width" combined:
Combining these two options is particularly useful for switching between two different navigation types
depending on the screen size:
Tabs -> Hide Below Width -> 850px
Bullets -> Hide Over Width -> 850px
RESULT:
Tabs will be shown above 850px screen size (desktop)
Bullets will be shown below 850px screen size (mobile)

5.4.9. Bullets
Enable Bullets / Bullet Style
Choose to enable/disable navigation arrows, and if enabled, choose between 15 different pre-built
styles.
Space / Direction
Set the spacing between the bullets in pixels, and choose if the bullets should be displayed horizontally
(bullets displayed side by side) or vertically (bullets placed on top of one another).

5.4.10. Tabs
Wrapping Container
Wrapper Padding is space between edge of slider and edge of thumbs/tabs container.
Span Wrapper:
ON: thumbs/tabs will always be stretched across the full size of the slider.
OFF: thumbs/tabs will be stretched to the slider’s Layers Grid.
Wrapper Color / Opacity
Adjust the color and opacity of the tab/thumbs section. It is only be visible if either “Space” or
“Wrapper Padding” exists.

Style, Visible Amount, Space & Direction
Style:
Choose between 7 different pre-built styles.
Visible Amount:
This is the amount of thumbs or tabs that will be visibly shown. For example, if you have 7 slides, but
only want 3 thumbnails to be displayed, technically the thumb strip will still contain 7 items, but only 3
thumbs will be visible at any given time, and the additional thumbs will only be shown on mousemovement.
Space / Direction
Set the spacing between the tabs/thumbs in pixels, and choose if the they should be displayed
horizontally (side by side) or vertically (placed on top of one another) .
Width, Height, Min. Width
Set the tab/thumb width and height. The width will act as a “Max Width”, and the “Height” will resize
proportionally.
For example, let’s say the slider itself was resized down by 50% for mobile. If the thumb width/height
were set to 100×50, the thumb size would also be resized down by 50%, and the new thumb
width/height would be 50×25.
However, this is where the “Min Width” value is useful. For example, let’s say the thumb width/height
was set to 100×50. If the “Min Width” were also set to “100px”, the thumbnails would never resize
down.

5.4.11. Thumbs
Basically all the fields are the same here as they are in Tabs. So take a look above in the previous chapter
for more information.

5.4.12. Touch
Touch Enabled
Choose to enable/disable touch navigation for mobile. If enabled, swiping the slider left or right with
your finger will change slides back and forth.
Drag Block Vertical

Allow for the page to be scrolled vertically when “touch” is enabled. For example, when “ON” is applied,
“swiping” the slider in a vertical direction will also scroll the page itself. But when set to “OFF”, the page
itself will not be scrolled when swiping the slider in a vertical direction.
Swipe Threshold, Min. Finger
Threshold
The swipe action sensitivity. A smaller number would mean that only a short “swipe” is needed for the
slide to change. A larger number would mean that a more elaborate “swipe” would need to take place
for the slide to change.
Min. Finger
The number of fingers needed for a “swipe” action to be registered. “1” finger is usually best, as that’s
what most users are used to, but depending on your site you can require that users use two fingers to
“swipe”, etc.
Swipe Direction
Horizontal is traditional left-to-right touch-swipe navigation.
Vertical is useful for when your slide animations are set to “Slide Vertical (Next/Previous)”. In this case,
swiping up or down would change the slides.

5.4.13. Preview Image Size
You can change here the size of the preview image, both the height and width in pixels.

5.4.14. Advanced Navigation
Keyboard Navigation
Choose to enable arrow keys to navigate between slides.
Key Direction
Vertical:
Up and down keys will act as “next / previous” controls for the slider.
Horizontal:
Left and right keys will act as “next / previous” controls for the slider.
Mouse Scroll Direction
Capture mouse-wheel movement to change between slides.

5.4.15. Parallax & 3D
Enable Parallax / Disable on Mobile
Choose to enable the parallax effect for the slider, and if enabled, choose to disable the effect for
mobile only (since parallax is based on mouse movement and page scrolling, parallax usually works best
on desktop computers).
Mouse Sensibility
Parallax Origin:
“Mouse Enter Point” – Parallax is based on where the mouse first entered the slider.
“Slider Center” – Parallax is always based on the very center point of the slider (usually the best option).
Event:
Choose “Mouse Move”, “Scroll Position” (page scrolling) or “Move & Scroll” (first two combined).
Animation Speed:
This is the transition duration for the content’s movement. Use a lower number such as “750” for fast
movement, and a higher number such as “2000” for smoother motion.
Parallax Levels
Each individual layer can be assigned a “Parallax Level”. And you can define up to ten different “levels”.
Applying different levels to different slide layers is what gives the content its “depth” in relation to other
parallax layers. In this example, you’ll notice that some content layers have less movement than others.
This is because the different layers have different “Parallax Levels” assigned.
When choosing your parallax level values, a smaller number would mean less movement, and a higher
number would allow for a larger amount of movement.
3D Settings
Turning the 3D on converts a parallax effect from a traditional 2D view into a 3-dimensional world.
3D Shadow:
Adds a CSS3 box-shadow to the elements to enhance the 3D visual.
3D Background Disabled:
Choose to disable the 3D behavior for the slide’s main background image. Then the 3D effect will only
be applied to the Slider’s Content Layers.

Slider Overflow Hidden:
Prevents the slider’s content from protruding past the slider’s normal boundaries.
Layers Overflow Hidden:
Prevents the slider’s Layer Content from protruding past the slider’s normal boundaries.
3D Crop Fix:
Helps to prevent Safari-specific 3D issues by separating content along the z-axis plane.
Mouse Sensibility
Animation Speed:
The transition duration for the content’s movement. Use a lower number such as “750” for fast
movement, and a higher number such as “2000” for smoother motion.
3D Depth Levels
This is the strength of the 3D rotation on the background and layer groups in relation to mouse
movement. The higher the value, the more movement!
In a 3D environment, applying different depth levels to different Layers is what brings the 3D world to
life. In this example, each content layer has a slightly different depth applied.

5.4.16. Google Fonts
The new Google Fonts section is just a reflection of what’s currently assigned to any of the slide’s Text
Layers.
Select a slide from the “Used in Slide” dropdown to be taken to the slide editor where the font is being
used.
And choose to load the “Latin” charset or not for the font.

5.4.17. Troubleshooting / Debug
Fallbacks
For compatibility with older mobile devices and legacy IE, you can choose to simplify the slider’s
functionality or replace it with an alternative image.
Simplify on iOS4/IE8

Animations will be set to simple “fade” for older iOS and IE, which will dramatically improve
performance for these environments.
Use Alternative Image
Choose to use an alternative image in place of the slider for mobile devices, IE8, or both. When an
alternative image is used, enter the image’s absolute url into the “Alternative Image” field.
Troubleshooting
Use the troubleshooting options to solve common conflicts with other plugins and themes.
jQuery No Conflict Mode
Using jQuery noConflict is considered best practice for WordPress, and Layer X Slider uses this by
default. But sometimes another theme or plugin may not be built using this best practice, which can
often cause a conflict. In these cases, setting this option to “OFF” can sometimes resolve this issue.
Put JS Includes to Body
Often solves conflicts with “minify” plugins and also certain themes that don’t call “wp_head()”
properly.
Output Filters Protection
Sometimes a theme runs special filters over the page’s content (against WP best practices), which
results in breaking the slider’s HTML markup (if you view the slider’s HTML source in your browser,
you’ll often find “<p>” tags injected throughout the slider’s markup).
The “Output Filters Protection” option will attempt to combat this conflict. “By Echo Output” will often
place the slider above all other content on the page, which is fine for sliders that are originally placed
above the other page’s content to begin with, but when the slider is meant to be shown below other
page content, “By Compressing Output” is best.
Debug Mode
This adds visual debug information when testing the frontend version of the slider.

5.4.18. Speed Monitor & Performance
Lazy Load Options
All:
Load all images in the slider after the page initially loads, ensuring no delays between slide content
when switching between slides.

Best for sliders with advanced navigation such as thumbnails, bullets and tabs.
Smart:
Load images from the very first slide after the page initially loads, and also preload images from
neighboring slides. For example, when the slider first loads, the 2nd slide will be preloaded in
anticipation of the slider changing. And then once the 2nd slide is viewed, the 3rd slide would then be
preloaded, and so on.
This is a great option for sliders that only contain basic navigation, where progression is always “next” or
“previous”.
Single:
Always load slide content “on demand”. Meaning only the first slide will be initially loaded, and
subsequent slides will only be loaded when it’s their turn to be shown in the slider.
No Lazy Loading:
All content will be loaded when the page first loads. Often ok for sliders with minimal content. Not
recommended for sliders with lots of slides and/or content.
Performance
The green bar shown is a general evaluation based on your LazyLoad choice, and the average image
sizes you’re using in the slider.
Toggle between the LazyLoad options to see the estimated Load Speed between common internet
speeds such as DSL, Cable (T1), etc.
Show Full Statistics:
View a detailed listing of Image Performance, Google Fonts, etc.
Show All Issues:
View items that could be slowing down your slider.
Reducing the file size for an image in Photoshop (using the Save for Web option) to a more reasonable
size such as 300kb or lower will dramatically improve the slider’s performance.

5.4.19. Import
Overwrite current slider settings and slides with those from the imported slider zip.
Browse
Select the slider import zip from your computer.

Custom Animations / Static Styles
Overwrite:
Overwrite previous styles and animations with those from the imported slider.
Append:
Preserve previous styles and custom animations (usually the best option).

5.4.20. Export
Export the current slider, creates a “zip” file that can be saved to your computer for later usage (i.e.
“imported” to a different website).

5.4.21. Replace URL
Image URL’s in your sliders are stored as absolute urls, so if you’re moving your site from one domain to
another (such as localhost to a live site), this tool can be used to update urls for the slider’s images with
the new site’s domain name.
Replace From:
The base url from the old site’s domain.
Replace To:
The base url of the new site’s domain.

5.4.22. Methods & Events
Extend the functionality with API methods and events.
Extend the functionality with API methods and events. All of the available methods and events are
listed in this section of the slider’s settings, and can be copied and pasted directly from this section into
the slider’s Custom JavaScript section.

5.4.23. Carousel
Infinity Scroll
OFF: Carousel will have a “beginning” and an “end”. Meaning when the end is reached, the slider will
not automatically loop, and the only way to view previous slides would be to navigate backwards.

ON: The carousel will loop infinitely. Meaning when the last slide is reached, the next slide shown be be
a copy of the very first slide, and so on, allowing you to click forward endlessly.
Space Between Slides
In a carousel format, normally items are shown as “blocks” that have spaces between them. This
spacing is optional, but if you want to display a traditional carousel look, add some spacing here.
Border Radius
Add rounded corners to your carousel items by applying a pixel value here. Or to achieve perfect circles,
add a “50%” border-radius.
Padding Top / Padding Bottom
Add some padding to the top and bottom of the carousel items, creating some extra space for the items
in relation to the rest of the page’s content.
Max Visible Items
This represents the number of items that will be visible. For example, using the number “3”, the
selected slide will be centered in the carousel, and then there will be 1 carousel item to the right
(representing the “next” slide), and 1 carousel item to the left (representing the “previous” slide).
Stretch Element
The selected carousel item will be stretched to cover the entire size of the slider.
When this option is used, “previous” and “next” carousel items will not be visible, regardless of the
“Max Visible Items” value.

5.4.24. Transformations
When a “varying” option is enabled, it means that the calculation will be based on the position of the
item in relation to the currently selected item.
For example, let’s say you have a carousel with 5 visible items, and a “Varying Scale” of “50%”. When
you cycle through the carousel items, the 5th item on the right will be scaled to 50%. Then when the
5th item becomes the 4th visible item, it will be scaled to 75%. And then when it finally reaches the
center of the carousel, it will be scaled to 100%.
But when no varying option is used, with the same carousel (5 visible items), the 5th item will have a
50% scale. And then when it becomes the 4th visible item, it will still have a 50% scale. And then when
it finally reaches the center of the carousel, only then will it scale from 50% to 100%.
Fade All Elements

All previous and next carousel items will be semi-transparent.
Varying Fade – See Special Note above
OFF: Fading will only occur for immediate neighboring items.
ON: Fading will occur throughout the visible cycle of the item.
Rotation
Apply a “skew” to items when the carousel progresses forward and back (this gives the effect of a
window opening from the side). Degree values ranging from 45 to 180 usually work best.
Varying Rotation – See Special Note above
OFF: Rotation will only occur for immediate neighboring items.
ON: Rotation will occur throughout the visible cycle of the item.
Scale
Scale previous and next slides down based on a percentage.
Max Scaledown
This is the percentage to scale previous and next items down. For example, 50% would means that
previous and next slides would be resized to half the size of the selected carousel item.
Varying Scale – See Special Note above
OFF: Scaling will only occur for immediate neighboring items.
ON: Scaling will occur throughout the visible cycle of the item.

5.4.25. Aligns
Choose a vertical and horizontal alignment for the carousel’s main item. For example, if the alignment is
set to “right center”, when the main selected item comes into focus, it will be aligned to the very right of
the slider’s layout.

5.4.26. Custom CSS/JS
You can enter here some custom CSS or JavaScript code.

6. Slide Settings
You can change different slide settings like background or editing the layers of the slide. You can also
change the animation or timeline of the layers.

6.1. Individual Slide Settings
6.1.1. Background
This is the main background image (or video cover/poster) that what will animate when the slide first
comes into view.
6.1.1.1. Regular Image
6.1.1.1.1. Set/Change Image
Click the “Change Image” button to select an image you’ve already uploaded, or to upload a new image
for the slide.
6.1.1.1.2. Source Settings
Image Source
The absolute url to the selected image (read-only).
Image Source Size
When you upload an image to a WordPress site, WP will automatically create multiple size versions of
the image that can be used. And for your slide’s main background image, you can choose which of these
versions you’d like to use.
Common options are “Original Size”, “Medium” and “Large”. A reasonably sized main background
image for web is around 1600×900 pixels. If your original images are larger than this, you can choose
“Large” or “Medium” here, and this will help to improve page loading performance.
Alt Text (the SEO title for the image)
From Media Library:
Value is taken from “WP Menu -> Media -> Library -> Select Image -> Alt Text”.
From Filename:
Alt text will be the same as the name of the file (i.e. “my-image.jpg”).
Custom:
Enter your own custom text to be used as the image’s Alt Text.

Background Fit
Cover:
The most common option. This will ensure that your image will always fill the entire size of the slider
(cropping may occur depending on the size ratio of the image in relation to the slider’s layout).
Contain:
Always fit the entire image inside the slider’s boundaries. Image cropping will never occur, but you may
end up with blank space on the sides of the image (similar to a letterbox movie on an older television
screen).
6.1.1.1.3. Parallax Level
To use this option, first make sure “Enable Parallax” is set to “ON” in the slider’s main parallax settings.
Adding a parallax level here will apply some movement to the main background based on mouse-move,
scrolling, or both.
Check out the “Parallax Levels” part of the link above for help with choosing a “level” if you wish to use
this option.
6.1.1.1.4. Ken Burns
An elegant pan/zoom that will move and scale the main background image slowly after the slide comes
into view.
Scale
From: The starting scale percentage of the image
To: The ending scale percentage of the image
If you want your image to “zoom in”, set the “From” value to “100” and the “To” value to something
larger than 100 (such as 150, which means the image would scale up by 50%).
If you want your image to “zoom out”, set the “From” value to something larger than 100, and then the
“To” value to “100”.
Horizontal / Vertical Offsets
These offset values are in relation to your main background image’s Background Position value (see
section B above).
For example, if your Background Position is “center center”, entering a Horizontal Offset of “100” would
mean 100px to the right of the very center, which would then serve as the starting position of the Ken
Burns effect. And a Horizontal Offset of “-100” would be 100px to the left of center.
Important Note

The main background image's "Background Position" (see section B above) plays an important role when
setting up your Ken Burns effect. For an example, set your "Scale To" value to "200", and your "Scale
From" value to "100". Then set the image's "Background Position" to "center center" and preview the
slide.
Then go back and change the "Background Position" to "top left", and this will give you a good idea of
how the main image's "Background Position" impacts the Ken Burns animation.
Rotation
Apply a starting and ending rotation for the effect. Smaller degrees such as 10-20 work best.
Easing
“Easing” is what gives a web animation that “real life” type of movement. For a traditional Ken Burns
effect, “Linear.easeNone” is usually the best choice. But you can test the other options to see which one
you like best.
Duration
The total time the Ken Burns effect will last, in milliseconds (1000 = 1 second). It’s usually best to set
this to the same number used for the slide’s delay value (“Edit Slide -> General Settings -> Slide Delay”).
6.1.1.2. External Image
For external images the Source & Source settings are different than local images and are explained next.
6.1.1.2.1. Set URL to External Image
Type the full url of the image you wish to use from the external domain, and then click the “Get
External” button.
6.1.1.2.2. Source Settings
Alt Text (the SEO title for the image)
This is an optional field to write an “alt” attribute for the loaded image and is useful for enhanced SEO.
Width / Height
Assign a width and height for the loaded image which will be used for resize calculations (it’s best to
enter the loaded url’s actual width and height here).
Background Fit
Cover is the most common option. This will ensure that your image will always fill the entire size of the
slider (cropping may occur depending on the size ratio of the image in relation to the slider’s layout).
Contain:

Always fit the entire image inside the slider’s boundaries. Image cropping will never occur, but you may
end up with blank space on the sides of the image (similar to a letterbox movie on an older television
screen).
6.1.1.3. Transparent / Color
Transparent Background
i.e. “No Slide Background”. Useful for when you want to use a single background image for your entire
slider.
Solid Colored Background
Use a solid color as the slide’s main background. Click the “Color” button to choose a color.
6.1.1.4. YouTube
6.1.1.4.1. Set YouTube ID and Cover Image
Set YouTube ID
To get your YouTube ID, visit the video on YouTube.com, and view the url in the browser’s address bar.
The ID will be after the “v=” part of the url. In the following url example, the ID is “cyohHyQl-kc”.
For example: https://www.youtube.com/watch?v=cyohHyQl-kc => cyohHyQl-kc
Set Cover Image (required)
Click the “Change Image” button to set a poster for the video, chosen from your WP Media library.
The video’s “cover” is what will animate when the slide first appears.
Use the following url format (replacing the “cyohHyQl-kc” part with your video’s ID) to download a copy
of the original high-res version from YouTube.com.
For example: http://img.youtube.com/vi/cyohHyQl-kc/maxresdefault.jpg
6.1.1.4.2. Source Settings
Force Cover
ON: Have the video cover the entire size of the slider (usually the best option for video backgrounds).
Depending on the video’s Aspect Ratio in relation to the slider’s size, cropping may occur.
OFF: The video will always respect its Aspect Ratio, and will never be cropped. Depending on the video’s
Aspect Ratio in relation to the slider’s size, blank space on the sides of the video may occur.
Dotted Overlay

Choose to display a “mesh-like” transparent graphic on top of the video, adding some extra style to the
video.
Aspect Ratio
YouTube offers 2 versions of the video that can be loaded which are 16×9 or 4×3. For video
backgrounds, 16×9 is usually best.
Start At / End At
Choose to start and/or end the video at a specific time, in minutes: seconds format.
Example “Start At” value: 00:17 (start the video 17 seconds in)
Example “End At” value: 02:17 (end the video at 2 minutes, 17 seconds)
Loop Video
Disable:
Video will only play once each time the slide is shown.
Loop – Slide is paused:
Video will loop endlessly, and the slide will never change unless the slider’s navigation is used (next
button clicked, etc.).
Loop – Slide does not stop:
Video will loop endlessly until the slide’s delay is reached. For example, if your slide’s are normally
meant to be shown for 10 seconds, but your video’s length is only 5 seconds, the video will play twice
before the slide actually changes.
Next Slide On End
ON: Slide will immediately change as soon as the video ends.
OFF: If video’s length is less than the slide’s delay, the slide will not change until the delay time has been
reached.
Rewind at Slide Start
ON: Video will always start from the beginning each time the slide is shown.
OFF: Once the video plays, if the slide is changed before the video actually ends, when coming back to
the same slide, the video will resume playing from the same point.
Mute Video

Choose to mute the video’s volume if it normally has sound.
Video Speed
A special option to play the video at a “fast forward” speed.
Arguments
Additional parameters that can be passed to the video from this list.
Not all params are supported, but useful options from the list are “rel”, “iv_load_policy”, and
“modestbranding” (see link above for descriptions of these params).
To add an additional parameter, prepend it to the beginning of the default params string.
6.1.1.5. Vimeo
6.1.1.5.1. Set Video
Set Vimeo ID
To get your Vimeo ID, visit the video on vimeo.com, and view the url in the browser’s address bar.
The ID will be after the “vimeo.com/” part of the url. In the following url example, the ID is “90840341”.
https://vimeo.com/90840341
Set Cover Image (required)
Click the “Change Image” button to set a poster for the video, chosen from your WP Media library.
The video’s “cover” is what will animate when the slide first appears.
6.1.1.5.2. Source Settings
Same as Youtube except for the Arguments field:
color=00adef&title=0&byline=0&portrait=0&api=1
6.1.1.6. HTML Video
Set Video URLS
Upload a video to your site via ftp, and enter the full url of the video or click the “Change Video” button
to choose a video from your WP Media library.
An “MPEG” version of your video (a file ending with “.mp4”) is mandatory.
MPEG will work almost everywhere except Firefox on Macs. Because of this, it’s also important to
include an alternative version of the video, which can be either “WEBM” or “OGV”. Firefox on Mac
supports both of these, so you only need one or the other.

Here’s a free tool you can use to create “ogv” and “webm” versions of your video.
Set Cover Image (required)
Click the “Change Image” button to set a poster for the video, chosen from your WP Media library. The
video’s “cover” is what will animate when the slide first appears.
6.1.1.7. Special
If you’re using a special content source such as a “Post-based Slider” or “Instagram”, you’ll be presented
with one of the 3 new options.
Special background source options and related background source settings listed below.
Post-based Slider / Specific Posts
Special Source Options:
Featured Image
Special Source Settings:
Identical to “Regular Image” chapter above
Instagram
Special Source Options:
Stream Image, Stream Video
Stream Image -> Source Settings:
Identical to “Regular Image” chapter above
Stream Video-> Source Settings:
Identical to “HTML5 Video” chapter above
Flickr / Twitter / Facebook
Special Source Options:
Stream Image
Special Source Settings:
Identical to “Regular Image” chapter above
YouTube / Vimeo
Special Source Options:

Stream Video
YouTube -> Stream Video -> Source Settings:
Identical to “YouTube” chapter above
Vimeo -> Stream Video -> Source Settings:
Identical to “Vimeo” chapter above

6.1.2. Options
Slide "Delay"
The amount of time the slide will be visible until the next one is shown.
This number also represents the duration of the slide’s layer animation timeline.

Slide State
Similarly to a traditional WordPress post, choose whether or not the individual slide should be officially
“Published” or not.
If “Unpublished”, the slide will still exist in the backend, but will be excluded when the slider is shown on
the frontend of your site.
Hide Slide After Loop
Choose if the slide should be hidden after a certain amount of loops. For example, the slide could be
shown initially, and then once the slider has looped through all the slides, the slide could be hidden on
the second time around.
Visible From / Visible Until

Normally the slide will always be visible by default. But you can choose specific dates to enable/disable
the slide.
Clicking one these fields will show a calendar popup where you can choose a date for each option.

6.1.3. Thumbnail
Set a thumbnail for the slide if your slider has thumbnail navigation, or just set a thumbnail to be used
for the slide’s admin preview.
Thumbnail Dimensions
Choose From Slider Settings (recommended setting), or “Original Size”.
Thumbnail Admin Purpose
Set this to “On” to use the thumbnail as the slide’s admin preview. Or if set to “Off”, the slide’s admin
preview thumb will be taken form the slide’s main background image.

6.1.4. Animation
Select Animation

To preview an animation, first select a category (Basics, Slide Simple). Then hover your mouse over one
of the choices, and a small live preview of the animation will appear. Once you find an animation you’d
like to use for the slide, select its checkbox, and then it will appear in the “Used Transitions” list.
If you wish, you can select multiple animations for the current slide, and the slide will alternate between
the selected animations in order each time the slide is shown within the slider.
When multiple animations have been chosen, select one from the list to adjust its individual settings.
To remove the selected animation, click the “x” icon.
And drag the arrow icons with your mouse to position the selections on top of one another, which will
change the order of the selected animations.
Animation Settings
The animation settings that will be applied to the selected animation.
The first two settings, "Slot / Box Amount" and "Slot Rotation" are only applicable to animations from
the "Slots And Boxes", "Curtain" and "Premium Transitions" categories.
Slot / Box Amount
This represents the number of “pieces” the image is divided into for these animations. Applicable to
animations from the “Slots And Boxes”, “Curtain” and “Premium Transitions” categories.
Click the option field for a special menu to help make your selection. “Thumbs Up” is the recommended
choice.
Slot Rotation
This applies a starting rotation to the slot-based animation. Applicable to animations from the “Slots
And Boxes”, “Curtain” and “Premium Transitions” categories.
Click the option field for a special menu to help make your selection. “Thumbs Up” is the recommended
choice.
Animation Duration
How long the animation will last from start to finish in milliseconds (1000 = 1 second).
An optimal number will depend on your chosen animation. For example, when using a simple “Fade”, a
number between 300-500 is usually best, but for more complex animations (especially when using an
“easeInOut” easing), a higher number such as 500-1000 will work well.
Easing In / Easing Out
Easing In is the easing applied when the background animates into view.

Easing Out is the easing applied when the background animates out of view (on slide change).
“Easing” is what gives a web animation that “real life” type of movement. Choose between over 35
options to see which one you like best.
The most commonly used options are “Power2.easeOut”, and “Power3.easeOut”.

6.1.6. Link
Class, ID and Attributes
For advanced usage, you can add a special class name, ID attribute or additional attribute to the HTML
list element that represents the slide.
Enable Link
Options are “Enable” (add a link to the entire slide), and “Disable” (no master slide link).

Regular Link Type
Slide Link
Add a url to one of your site’s pages or an external website.
Type in {{link}} to automatically link to original pages for special content sliders such as post-based
sliders, Twitter, etc.
Link Target
Options are “Same Window” or “New Window” (i.e. new tab).
Link Sensibility
Front:

Slide’s hyperlink will be placed on top of the slide’s content layers (only a good option when additional
content layers are not hyperlinked).
Back:
Slide’s hyperlink will be placed behind the slide’s content layers, allowing for additional hyperlinked
content layers.
To Slide Link Type
Link To Slide
Options are “Next Slide”, “Previous Slide” or a specific slide number.
You can also choose “Scroll Below Slider”, which will scroll the page to additional content beneath the
slider when the slide is clicked.
Link Sensibility
Front:
Slide’s hyperlink will be placed on top of the slide’s content layers (only a good option when additional
content layers are not hyperlinked).
Back:
Slide’s hyperlink will be placed behind the slide’s content layers, allowing for additional hyperlinked
content layers.

6.1.7. Info
Slide Info is special meta that can be used for certain navigation types. You can use these parameters for
entering information like for tabs.

6.2. Slide Layers
6.2.1. Layer Controls
Just select Add Layer and one of the options available in the dropdown.
Layer Selector & Controls
Toggle between layers for editing.

Click the "lock" icon to prevent the layer from further editing, and then when locked, click the "unlock"
icon to enable editing again.
Click the "eye" icon to toggle layer visibility in the WYSIWYG editor.
Layer Editing & Controls
1. Edit the Layer's content (i.e. change Text/HTML, change Image source, etc.)
2. Snap the Layer back to its original size (useful for Image Layers)
3. Delete the currently selected Layer
4. Duplicate the currently selected Layer

Slide/Layer Canvas
The layer’s WYSIWYG editor is a visual representation of the current slide.
Layers Grid Boundary
The lines that represent the current Layers Grid size based on the current Screen/Device selection.
Helper Grid Guide Lines
The solid green lines are optional pixel based guide lines that can help when positioning your layers on
the canvas.
Snap to
When dragging and dropping your Layers around the canvas, you can choose to snap the Layer’s
position based on the Helper Grid Lines or in relation to other layers.
Screen/Device
To use this option, you first have to enable a Custom Grid Size for additional screens/devices.
Toggling between the different options here will allow you to style and position your Layer content
based on the selected screen/device.
For example, if you had a text-based layer, you could assign it a font-size of 64px, with a top-right
position for desktop view. Then if you switch to the smartphone view, you could change the layer’s
font-size to 32px, and give it a bottom-left position.

6.2.2. Text/HTML, Icons & External Shortcodes
Text/HTML
A text box appears when you create or edit a text layer. In there you can enter text or HTML code.
Icons
Click the grid icon to open the popup with icons. Then choose from over 350+ possible icons. And then
after making a selection, the icon's HTML will automatically be entered into the layer.

6.2.3. Image Layer
First add a new image layer. Then select or upload the image you wish to add. Position and Resize the
Image on the stage by changing the Custom Size field

6.2.4. Audio Layers

Add an Audio Layer to the stage then choose your audio file.
Audio Settings
Loop: Always replay the song when it ends.
Autoplay: Play the song without any type of user-interaction needed (not applicable for mobile devices,
most mobile devices do not allow for media autoplay).
Stop other Media: Pause all other video and audio in the current slide.
Next Slide on End: Automatically navigate to the next slide when the song ends.
Rewind at Slide Start: Always replay the song from the very beginning when the slide becomes visible
again.
Hide Controls: Choose to disable the HTML5 Audio controls.
Volume: Set the volume for the song (a number between 0-100)
Segment Start: Start the song at a specific time
Segment End: End the song at a specific time
Invisible on Frontend: Play the audio in the background
Audio Preload:
Metadata: Only load the audio file’s meta data when the page loads (usually the best choice for songs
that are NOT set to autoplay)
Progress: Play the song as soon as downloading begins
Can Play: Play the song as soon as the first chunk has loaded (usually the best choice for songs that are
set to autoplay)
Can Play Through: Only starts the song when the entire song has fully downloaded!
Ignore Preload After: Play the song regardless of the desired preload setting after a certain amount of
seconds has elapsed.

6.2.5. Video Layers
Enter the YouTube ID or full URL, then click the “Search” button.
6.2.5.1. YouTube
YouTube Sizing

OFF = YouTube’s video iframe will be whatever width and height you choose (see Layer Styles).
ON = YouTube’s video iframe will cover the enter size of the slider (width and height will both
automatically set to 100%).
Force Cover
OFF = Video will have a CSS background-size of “contain”. This means the video will never be cropped,
but depending on the video’s original size ratio in relation to the slider’s actual size, blank space on the
sides of the video may occur.
ON = Video will have a CSS background-size of “cover”. This means the video will always cover the entire
size of the slider, but depending on the video’s original size ratio in relation to the slider’s actual size,
video cropping may occur.
Dotted Overlay *
Choose to display a “mesh-like” transparent graphic on top of the video, adding some extra style to the
video.
* only applicable if “Force Cover” is set to “On”.
Aspect Ratio *
YouTube offers 2 versions of the video that can be loaded which are 16×9 or 4×3. For video
backgrounds, 16×9 is usually best.
* only applicable if “Force Cover” is set to “On”
YouTube Settings
Loop Video
Disable:
Video will only play once each time the video is initially played.
Loop – Slide is paused:
Video will loop endlessly, and the slide will never change unless the slider’s navigation is used (next
button clicked, etc.).
Loop – Slide does not stop:
Video will loop endlessly until the slide’s delay is reached. For example, if your slide’s are normally
meant to be shown for 10 seconds, but your video’s length is only 5 seconds, the video will play twice
before the slide actually changes.

Autoplay
Choose to autoplay the video when it animates into view.
Or choose On 1st Time to autoplay only the first time the slide is shown.
Or choose Not on 1st Time to only autoplay after the slide is shown at least once.
Stop Other Videos
If more than one videos are present in the slide at the same time, choose this option to make sure only
one video can be played at a time.
Allow FullScreen
If chosen and controls are not hidden, the controls will include a Full Screen button.
Next Slide on End
ON: Slide will immediately change as soon as the video ends.
OFF: If video’s length is less than the slide’s delay, the slide will not change until the delay time has been
reached.
Rewind At Slide Start
ON: Video will always start from the beginning each time the slide is shown.
OFF: Once the video plays, if the slide is changed before the video actually ends, when coming back to
the same slide, the video will resume playing from the same point.
Hide Controls
Choose to hide the video’s default player controls.
Mute Video
Choose to mute the video’s volume if it normally has sound.
Volume (0-100)
Set the default volume level for the video.
Start At / End At
Choose to start and/or end the video at a specific time, in minutes:seconds format.
Example “Start At” value: 00:17 (start the video 17 seconds in)
Example “End At” value: 02:17 (end the video at 2 minutes, 17 seconds)

Show Cover at Pause
Show the video’s preview image (see Visibility section) whenever the video is paused.
Video Speed
A special option to play the video at a “fast forward” speed.
YouTube Visibility
Preview Image
Enter a custom url, or click the “Image Library” button to choose an image from the WP Media library.
Or choose “Video Thumbnail”, which will then automatically load the video’s preview image from
YouTube.com.
Disable Mobile
Choose to disable the video for mobile devices (video layer will simply not be shown).
Only Preview on Mobile
When enabled, only the video’s preview image will be shown on mobile devices (video will never be
loaded).
6.2.5.2. Vimeo
Same as Youtube.
6.2.5.3. HTML Video
Poster Image URL
Click “Set Image” to choose a preview/poster image for the video from your WP Media library, or enter
url to the image directly.
MP4, WEBM & OGV Url
Upload your video files to your website via ftp, and then enter their url locations here.
You could also use the “Set Video” option to choose or upload a video from your WP Media library, but
depending on the size of your video(s), they may need to be uploaded via ftp.
An “.mp4” version of your video is mandatory, and will work almost everywhere except Firefox on Macs.
Because of this, it’s also important to include an alternative version of the video, which can be either
“WEBM” or “OGV”. Firefox on Mac supports both of these, so you only need one or the other.
Here’s a free tool you can use to create “ogv” and “webm” versions of your video.
HTML5 Video Sizing

OFF = Video size will be whatever width and height you choose (see Layer Styles).
ON = Video will cover the enter size of the slider (width and height will both automatically set to 100%).
Force Cover
OFF = Video will have a CSS background-size of “contain”. This means the video will never be cropped,
but depending on the video’s original size ratio in relation to the slider’s actual size, blank space on the
sides of the video may occur.
ON = Video will have a CSS background-size of “cover”. This means the video will always cover the entire
size of the slider, but depending on the video’s original size ratio in relation to the slider’s actual size,
video cropping may occur.
Dotted Overlay *
Choose to display a “mesh-like” transparent graphic on top of the video, adding some extra style to the
video.
* only applicable if “Force Cover” is set to “On”.
Aspect Ratio *
Choose which aspect ratio the video should be resized by. For video backgrounds, 16×9 is usually best.
* only applicable if “Force Cover” is set to “On”
The rest of the options are same as YouTube, read above.

6.2.6. Buttons
Adding a traditional button is easy – just click on the “button” item.
Preview Canvas:
Toggle between the “white” and “black” squares at the top left to see what the button would look like
on a light or dark canvas.
Text:
Edit the button’s default text to be included with the button.
Idle State:
Choose the button’s default background color, text color, border styles, icon* and font-family.
Hover State:

Choose the background color, text color, border styles, icon* and font-family for the button on
mouseover.
* Some buttons include an icon in the default state, and some include the icon on rollover (hover your
mouse over the different buttons to see which ones include an icon on rollover).
Add Predefined Button
Scroll the left panel to see the list of predefined buttons that can be chosen from.

6.2.7. Shapes
Toggle the white and black squares in the top left corner to see what the shape would look like against a
light or dark background. Then adjust the shapes colors, opacity, border and size.
When both “Full Width” and “Full Height” are selected, you’ll then have the ability to enter some
padding for the shape, which can be based on pixels or a percentage.

6.2.8. Import Layer
Select the slider that contains the Layer you wish to import from. Narrow your search down to a specific
slide. Narrow your search down even further to a specific Layer Type. Click the "+" icon to import the
Layer. And then click the "x" to close the window.

6.3. Layer X Style
6.3.1. Predefined Templates
When styling your layer, choose from one of the 100+ styles that’s closest to your desired styling. Then
this will act as a “preset” of styles that can be further adjusted with the WYSIWYG editor.
When editing your layers, you’ll start of with a predefined layer style. And additional settings
adjustments you make will only be applied to the current layer.
However, once you’ve made adjustments for a specific layer, you can save your adjustments as a new
“predefined” layer style to use for additional layers.
1. Save: Override the current preset style with your layer’s current settings (original predefined style will
be permanently modified).
2. Save As: Create a new preset style based on the current layer settings (original predefined style will
not be overridden).
3. Rename: Change the title of the currently selected preset style for your own convenience.

4. Reset: Revert currently adjusted settings to the predefined layer styles original settings.
5. Delete: Permanently delete the current predefined layer style (can not be undone!).

6.3.2. Style & Positioning
After adding your layer to the slide, use the “Style” section to format text, adjust layer positioning, and
also apply additional CSS styles to your layer content.
Click the “+” button to activate the advanced styling section or click the “+” button to activate the
advanced styling section.

6.3.3. Layer Animations & Timeline
Layer Animations
When setting your layer animations, choose from one of the 30+ animation templates that’s closest to
your desired look. Then this will act as a “preset” of settings that can adjusted further.
After adding a layer to the slide, and selecting it in the preview canvas, when you click the “Animation”
tab, you’ll see a live preview of the layer’s animation.
Click the “Pause” button to stop the admin preview. And then click the same button to preview your
animation once again.
Every content layer has a “Start” animation that will happen when the layer first appears, and an “End”
animation for when the layer disappears.
The actual time when these animations take place will depend on the layer’s “Visible Timeline”, which is
set in the Layers Timing and Sorting part of the slide’s admin.
Presets, Easing, Speed & Text-splits

Special Note:
Select "No Animation" from #1 above if you do not want your layer to animate.
Animation Template
Choose from over 30+ prebuilt animations. And preview each option by clicking the “Play” button next
to the “Animation” tab.
Animation Easing
“Easing” is what gives a web animation that “real life” type of movement. Choose between over 35
options to see which one you like best. The most commonly used options are “Power2.easeOut”, and
“Power3.easeOut”.
Animation Speed
How long the animation will last from start to finish in milliseconds (1000 = 1 second).
An optimal number will depend on your chosen animation. For example, when using a simple “Fade”, a
number between 300-500 is usually best, but for more complex animations (especially when using an
“easeInOut” easing), a higher number such as 500-1000 will work well.
Animate by Words, Letters or Lines
For text-based layers, you can animate words, letters or lines one by one with this option.
Choose “No Split” to just animate the entire layer at once.
Split Animation Delay
When animating by words, letters or lines, the essence of the effect is that each will animate one after
the other. The delay value here is the amount of time that will be used for this sequenced animation.
The delay value is in milliseconds. A number between 5-30 usually works best.
Advanced: Opacity, Transforms & Masking
Click the “+” button to edit the “Start” or “End” animation’s advanced settings.
START Animation Settings = Animate FROM these settings
END Animation Settings = Animate TO these settings
Offset

X = Horizontal Axis
Y = Vertical Axis
Z = 3D Axis
Choose “Inherit” to honor the animation’s original settings, “Custom” to enter a specific pixel value, or
try out one of the other options to see which one you like best.
Opacity
Adjust the animation’s Opacity (i.e. “transparency”) level.
Choose “Inherit” to honor the animation’s default setting, “Random” to always randomize the value
each time the slide is shown, or “Custom” to enter a special value (a number between 0-1).
Rotation
1. Animate 3D rotationX (rotate around x-axis)
2. Animate 3D rotationY (rotate around y-axis)
3. Animate 2D Rotation (circular, non-3D rotation)
Choose “Inherit” to honor the animation’s default setting, “Random” to always randomize the value
each time the slide is shown, or “Custom” to enter a special value (a positive or negative number usually
between 0-360).
Scale
1. Animate scaleX (layer’s width)
2. Animate scaleY (layer’s height)
Choose “Inherit” to honor the animation’s default setting, “Random” to always randomize the value
each time the slide is shown, or “Custom” to enter a special value (a number between 0-1).
For a traditional “Zoom” type animation, set the “scaleX” and “scaleY” parameters to the same values.
Scew

1. Animate skewX (horizontal angle)
2. Animate skewY (vertical angle)
Choose “Inherit” to honor the animation’s default setting, “Random” to always randomize the value
each time the slide is shown, or “Custom” to enter a specific amount of pixels to skew the layer by.
Masking
X = Apply a horizontal mask for the animation
Y = Apply a vertical mask for the animation
Apply a mask to the layer, which will result in the animation only becoming visible once the layer is
positioned inside the masked area.
Animation Templates Management
When editing your animations, you’ll start of with a predefined animation template, and additional
settings adjustments you make will only be applied to the current layer.
However, once you’ve made adjustments for a specific animation, you can save your adjustments as a
new “Animation Template” to use for additional layers.
1. Save: Override the current preset animation with your adjusted current settings (original animation
template will be permanently modified).
2. Save As: Create a new Animation Template based on the current settings (original predefined
Animation Template will not be overridden).
3. Rename: Change the title of the currently selected Animation Template for your own convenience.
4. Reset: Revert currently adjusted settings to the predefined Animation Template’s original settings.
5. Delete: Permanently delete the current predefined Animation Template (can not be undone!).
Loop Animations
Apply continuous, animated movement to the layer even after it’s initially animated into view.
1. Loop Animation
Visual Examples: Pendulum | Slide Loop | Pulse | Wave
2. Loop Speed
The amount of time the animation should last before it loops again in seconds. A number between 2-5
usually works best.

3. Loop Easing *
“Easing” is what gives a web animation that “real life” type of movement. For Loop animations, try one
of the “easeInOut” options such as “Power1.easeInOut” for a smooth, continuous motion.
Loop Parameters
Pendulum / Rotate
Choose the rotation degrees for the start and end of the looped animation. Use a negative number for
the “start” value” and a positive number for the “end” value.
Rotation X/Y point (transform-origin) is percentage based values that will act as the axis point for where
the layer rotates from.
Slide Loop
Loop the layer from one point to another. “X” values are the horizontal plane (left to right), and “Y”
values are the vertical plane (top to bottom).
Pulse
Adjust the Zoom Start and Zoom End parameters to continuously zoom the layer in and out. A value of
“1” equals 100%, so “1.5” would be 150%, etc.
Wave
Rotation X/Y point (transform-origin) is the percentage based values that will act as the axis point for
where the layer rotates from.
Start Angle is the value here would be the starting position for the animation when this loop begins.
Radius of Rotation defines a pixel-based orbital area that the layer will animate around.
Animation Timeline

The Layers Timing & Sorting section is a visual representation of the slide’s animation sequence. It’s also
where you can adjust the z-index depth for each Layer (i.e. place a Text Layer on top of an Image Layer,
etc.).
The First line represents the slide’s main background. The other ones represent the layers.
Start Time: The time when the Layer will begin to animate into view.
Start Speed: The total duration of the Layer’s initial animation when it comes into view.
End Time: The time when the Layer will begin to animate out of view.
End Speed: The total duration of the Layer’s final animation when it transitions out of view.
Drag the Layer’s timeline left and right to position the layer’s “visibility” within the lifetime of the
current slide.
Click the arrow in the left panel to set the Layer's "End" animation time to equal the very end of the
slide's timeline.
The clock icon represents a custom "End" time for the layer (layer will disappear before the slide's
official end has been reached).

6.3.4. Behavior
Auto Responsive – choose to make the layer responsive by default (layer will resize when slider resizes).
Child Elements Responsive -If the layer contains additional content (raw HTML, shortcode from other
plugin, etc.), the slider will attempt to resize all nested elements.
Boxed (Grid Based) vs. Full-Width (Slide Based) Alignment
Layer Alignment is particularly useful for when using Full Width slider, as sometimes you want your
content to align to the sides of the screen as opposed to your slider’s “Layers Grid” size.
Grid Based (boxed) - Layer will always be aligned and positioned based on the slider's grid size (i.e.
115px from the left of the Layer's Grid boundaries).
Slide Based (full-width) - Alignment and positioning of Layers will always be based on the slider's actual
size (i.e. 115px to the left of the screen).
Responsiveness / Offset
Responsive Offset: ON
When the slider is resized down by 50%, the Layer’s original “Offset” values are also reduced by 50%.
Responsive Offset: OFF

When the slider is resized down by 50%, the Layer’s original “Offset” values are NOT reduced or
changed.
Lazy Loading:
Default Settings – Image will be loaded according to the slider’s global Lazy Load setting.
Force Lazy Loading – Lazy Load the image regardless of global Lazy Load setting.
Ignore Lazy Loading – Do not Lazy Load the image regardless of global Lazy Load setting.
Source Type:
Choose which version of the image should be loaded. Often “Original” can equal a very large file size, so
usually “Large” or “Medium” is a good choice for optimal loading performance.
Choose “Default Setting” to use the slider’s global Image Source Size setting. Or override the default
setting with one of the other choices.

6.3.5. Visibility
Choose when the layer should be visible such as per device, above a certain screen width, or on mouse
hover.
Desktop:
Show/hide layer on screens higher than 1024px width (regular desktop view).
Notebook:
Show/hide layer on screens 1024px wide or higher (tablet landscape).
Tablet:
Show/hide layer on screens 768px wide or higher (tablet portrait / smartphone landscape).
Smartphone:
Show/hide layer on screens 360px wide or higher (smartphone portrait).
Hide "Under" Width
Layer will be hidden according to slider’s Hide Element Under Width -> Predefined Layers value in the
slider’s main settings.
Only on Slide Hover

Layer will only be shown when the user hovers their mouse over the screen (for mobile devices, the
hover equivalent would be a finger “tap”).

6.3.6. Actions
6.3.6.1. Introduction
An “Action” is essentially something that happens when the user interacts with the Layer’s content
(clicking the layer, or mouse hovers).
To add a Layer Action, select the Layer on the preview stage canvas, and then from the "Actions" tab,
click the "+" button.
Next, choose what type of mouse interaction should be applied to the Layer (click, "Mouse Enter"
(mouse-over/hover), or "Mouse Leave" (i.e. mouse-out).
To show a "hand cursor" when hovering your mouse over the Layer, apply the settings.
6.3.6.2. Link Layer to another web page
Actions Menu
Choose “Simple Link”
Link Url
Enter the full url (including the “http://” part) of the web page you wish to hyperlink to.
Link Target
Choose “Same Window” to open the link in the same window/tab.
Choose “New Window” to open the link in a new window/tab.
Link Type
Choose “A Tag Link” for best SEO practices. Or choose “jQuery link” if you’d rather the link be opened
with JavaScript instead.
6.3.6.3. Navigate to a different slide
Useful for building custom navigation, such as a special slider menu, etc.
6.3.6.4. Play/Pause Slider
Useful for building a special “play/pause” button to control the slider’s autoplay.
6.3.6.5. Scroll below slider
Useful for applying to a “Read More” button, which would then scroll to additional content below the
slider. Use the “Scroll Offset” option to scroll additional pixels below the slider.

6.3.6.6. Show/Hide Additional Layers
Add interactivity to your slides by controlling Layer visibility with these options (i.e. clicking one Layer
shows another Layer).
To get started, choose a "Target" Layer that you'd like to control. Next, choose one of the following
options from the Layer Actions menu.
Start Layer "in" Animation"
“Target” Layer will be initially hidden, and then animated into view when current Layer’s Action is
triggered (on-click or hover).
Target Layer
Other Layer that will be animated into view.
Delay
Add a small delay (in milliseconds) before the Target Layer is animated into view.
Animation Timing
Choose “Wait for Trigger” to honor the Layer Action’s default behaviour.
Or use one of the additional options to “replay” animations upon user-interaction.
Trigger Memory
Choose “Keep Last Selected State” to remember the user’s previous interaction.
Choose “Reset Animation and Trigger States every Loop” to not remember the user’s previous
interaction.
Start Layer "out" Animation
“Target” Layer will animate out of view when current Layer’s Action is triggered (on-click or hover).
Target Layer
Other Layer that will be animated out of view.
Delay
Add a small delay (in milliseconds) before the Target Layer is animated out of view.
Animation Timing
Choose “Wait for Trigger” to honor the Layer Action’s default behavior or use one of the additional
options to “replay” animations upon user-interaction.

Trigger Memory
Choose “Keep Last Selected State” to remember the user’s previous interaction.
Choose “Reset Animation and Trigger States every Loop” to not remember the user’s previous
interaction.
Toggle Layer Animation
“Target” Layer will alternately animate into and out of view as current Layer’s Action is triggered (onclick or hover).
Target Layer
Other Layer that will be animated out of view.
Delay
Add a small delay (in milliseconds) before the Target Layer is animated out of view.
At Start
The Target Layer’s initial visibility, where “Play in Animation” equals “initially visible” and “Keep Hidden”
equals “initially hidden”.
Animation Timing
Choose “Wait for Trigger” to honor the Layer Action’s default behaviour.
Or use one of the additional options to “replay” animations upon user-interaction.
Trigger Memory
Choose “Keep Last Selected State” to remember the user’s previous interaction.
Choose “Reset Animation and Trigger States every Loop” to not remember the user’s previous
interaction.
6.3.6.7. Play/Pause/Mute/Unmute Audio or Video
Useful for building a special “play/pause” or “volume/mute” button for Video or Audio.
Start Media: Play the video/audio
Stop Media: Pause the video/audio
Toggle Media: Toggle the video/audio’s play/pause state
Mute Media: Mute the video/audio’s volume

Unmute Media: Turn the video/audio’s volume back on
Toggle Mute Media: Toggle the video/audio’s mute/unmute state
Toggle Mute All Media: Toggle the volume of all video or audio for the current slide and Static Layers
slide.
Video Action
Choose to Start, Stop, or Toggle the play/pause state of the Target Layer’s Video.
Target Layer
Layer that contains the Video (can be current Layer or a different Layer).
Delay
Add a small delay (in milliseconds) before the Action takes place.
6.3.6.8. Advanced Actions
Simulate Click:
Useful if other Layer has jQuery event attached that needs to be triggered.
Target Layer
Other Layer to simulate the click action.
Delay
Add a small delay (in milliseconds) before the Target Layer is animated out of view.
Toggle Layer Class:
Add/Remove CSS Class for a Layer.
For example, you could add a special Class to the Layer for your custom CSS, and then toggle this class
on and off with this Layer Action.
Target Layer
Layer where Class will be added/removed (can be current Layer or a different Layer).
Delay
Add a small delay (in milliseconds) before the Target Layer is animated out of view.
Class
Name of the CSS Class to toggle on and off.

Toggle FullScreen:
Switch the slider to a FullScreen Layout
Layer Action options are “Go FullScreen”, “Exit FullScreen”, and “Toggle FullScreen”.

6.3.7. Parallax
Apply a “Parallax Level” (1-10) or “3D Depth” to the layer. Click here to learn about the slider’s
Parallax/3D option works and how it can be used.
If Parallax is turned on, but without 3D, the Layer can be assigned a “Parallax Depth”.
If both Parallax and 3D are turned on, the Layer can be assigned a “3D Depth”.

6.3.8. HTML
Layer attributes can help with adding advanced Custom CSS for a specific Layer. For example, a custom
class could be added to a Layer, and then some CSS could be applied to the Layer (added here). The
example below would apply a CSS3 text-shadow to the Layer.
ID, Class, Title, Rel: Add a custom attribute to the Layer for advanced usage.
Image Alt Text: Add “Alt” text for Layer Images for maximum SEO.
From Media Library: Alt text will be taken from “WP Main Menu -> Media -> Library -> Select Image ->
Alt Text”.
From Filename: Image’s filename will be used for the Alt text.
Custom: Enter a custom value (field #6 above) for the Alt text.

Thank you for purchasing our plugin!
We would be glad to help you if you have any questions in the comments section or
send us an email to support@wpicode.com

YOU LIKE OUR PLUGIN?
Keep us motivated to deliver new features by giving us a good review
Thank You!

